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Wo
Welcome

Welcome to Huntsville Operations Support Center (HOSC) training provided by the HOSC 
Training Team (HTT). 

If you are interested in scheduling additional training, submit a training request form via the 
Internet. The homepage can be accessed through a secure connection at:

https://red-dwarf.msfc.nasa.gov/webdoc/training/htt.html

Another option is to contact the HOSC Training Coordinator, Cindy Jorgensen, at (256) 461-4927.
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Training Contacts

If you have questions regarding training, contact your EO62 training representative or one of the 
following individuals:

Workbook Overview

The majority of the workbooks are designed to be self-paced requiring very little assistance from 
an instructor. The following table lists the workbooks and their associated course number:

Name Organization
Phone 

Number
E-mail Address

Lisa Watson EO39 544-3523 lisa.watson@.msfc.nasa.gov

D.C. (Sparky) Goodman NTI 461-4545 sparky.goodman@ums.msfc.nasa.gov

Michelle Adrian NTI 461-4514 michelle.adrian@ums.msfc.nasa.gov

Gene Sobczynski NTI 461-4516 eugene.sobczynski@ums.msfc.nasa.gov

James (Jay) Washburn NTI 461-4543 james.washburn@ums.msfc.nasa.gov

Cindy Jorgensen NTI 461-4927 cindy.jorgensen@ums.msfc.nasa.gov

Workbook Numbering System

Workbook 
Number

Title
Associated 

Course

Workbook 1 HOSC End-User Software Training HOSC-1000
HOSC-1010
HOSC-1020
HOSC-1030

Workbook 2 Using the Databases HOSC-2050

Workbook 3 Using the Exception Monitor Application HOSC-2060

Workbook 4 Using the Display Generation and Operation 
Applications

HOSC-2070

Workbook 5 Using the Computation Generation and Operation
Applications

HOSC-2080

Workbook 6 Using the Scripting Applications HOSC-2090

Workbook 7 Using the NRT Data Request Applications HOSC-2100
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This workbook cover course:

HOSC-2060 - Using the Exception Monitor Application

This course will provide the trainee with the information necessary to monitor selected data limit 
violations and issue advisory messages when those limits occur using the Exception Monitor 
application.

Workbook 8 Using Applix HOSC-2110

Workbook 9 Using FrameMaker HOSC-2130

Workbook 10 Using Electronic Mail HOSC-2140

Workbook 11 Using the Payload Information Management System (PIMS) HOSC-2150
HOSC-2160

Workbook 12 Using the Pixmap Editor HOSC-2170

Workbook 13 Using the Ground Support Equipment Packets Application HOSC-2180

Workbook 15 Using the End-User Command Applications HOSC-2120

Workbook 22 Workstation Overview and General Purpose Utilities Training HOSC-1040

Privileged Applications

Workbook 16 Using the Privileges within the Database Applications HOSC-3000

Workbook 17 Using the Command System Management Application HOSC-3010

Workbook 18 Using the User Configuration Management Application HOSC-3020

Workbook 19 Using the System Monitor and Control Applications HOSC-3030
HOSC-3040

Workbook 20 Using the Data Packet Generator Application HOSC-3050

Workbook 21 Using the Database Monitor and Control Application HOSC-3060

Workbook Numbering System (Continued)

Workbook 
Number

Title
Associated 

Course
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Workbook Layout

The workbooks include a welcome section that details how the document is divided into modules as well 
as what is contained within each module. The modules include a discussion of the main topic of the 
module, a step-by-step “Try It...” and review questions. Modules have been included that “put it all 
together” and provide exercises to reinforce what you have learned.  

This particular application is provided to assist you, the user, with background data limit monitoring 
capability. This course will provide a thorough introduction to the purpose and structure of the software 
and will set you on a path toward understanding the applications and mastering the manipulation of them. 

This workbook and the accompanying course are divided into three modules. At the end of each module, 
you are presented with a small number of review questions which allow you to test yourself on the 
important points covered in that module. In addition, modules two and three also contain scenarios 
followed by step-by-step “Try It...” exercises which will give you hands-on experience using the 
Exception Monitor software.

Each module features an exercise which will apply the skills you acquire during the course. The six 
modules include:

Module 1: An Introduction to Exception Monitor
Module 2: Exception Monitor Configuration Files
Module 3: Exception Monitor Features 

Given the extensive technical requirements, extreme effort has been taken to make the software as 
intuitive and user-friendly as possible. Hopefully, your experience with the software will be rewarding, 
and you’ll find it satisfies your individual needs. 
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Workbook Objectives

At  the completion of this workbook, you should be able to:

■ State the purpose of Exception Monitor (EM) and its elements
■ List the two types of exception monitoring
■ Create EM configuration files
■ Start the monitor process
Workbook 3 ix Objectives
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Module 1
An Introduction to Exception Monitor

The Exception Monitor (EM) application performs the following functions for you:

■ Provides exception monitoring on selected Measurement/Stimulus Identifiers (MSIDs) for 
Limit/Expected State (LES) violations

■ Issues exception advisory messages when LES violations occur
■ Prints a status report of monitored MSIDs

Exception monitoring is a process which checks MSID values from telemetered data for violations of 
previously set limits or states. The Exception Monitor application checks for the following violations:

■ Limit
■ State
■ Delta limit

A Limit violation occurs when an MSID value exceeds a predefined limit. For example, if the 
temperature of an on-board experiment is expected not to exceed 25 degrees Celsius, Exception Monitor 
checks the MSID carrying the temperature of the experiment. If the value of the MSID exceeds the limit, 
the user is notified.

A State violation occurs when an expected state exception has occurred (e.g., OFF instead of ON). For 
example, an on-board heater is monitored to ensure whether it is on or off. If the heater is off (according 
to the MSID carrying this value) but it is expected to be on, the user is notified.

A Delta limit violation occurs when the value of consecutive samples checked exceeds a defined delta.

When an LES violation occurs, the exception advisory message is displayed in the main window of the 
Message Handler application. In addition, you can also configure MSIDs to issue an acknowledgment 
dialog box which will require that you acknowledge receipt of the message.

The Exception Monitor application can be invoked in two different ways:

■ User
■ Project

You invoke User Exception Monitor on your workstation for local monitoring. Project Exception 
Monitor can be invoked by a member of the Integrated Support Team (IST) on a project server for 
project-wide monitoring.

Project Exception Monitor functions identically to User Exception Monitor except that it monitors 
MSIDs on a project-wide basis and multicasts exception advisory messages to all users associated with 
Workbook 3 1-1 Module 1



the project. The telemetry database will indicate which MSIDs are being monitored by Project Exception 
Monitor. IST members can also enable or disable additional MSIDs for monitoring.

Before beginning Exception Monitor, you must have a Huntsville Operations Support Center (HOSC) 
account and should have basic knowledge of the other HOSC applications. HOSC applications are 
designed to work together as an integrated suite of products.

System Initialization

When you obtain the necessary HOSC account, you’ll be provided a username and a temporary 
password. These two items are required before you can login and begin using the HOSC software. When 
you’re presented the login screen, click with the left mouse button in the Login: text field and type your 
username. Press , type your temporary password, and press  again. This should initialize the 
system and invoke the Launchpad and Message Handler applications. 

Note: If the system responds with Login Unsuccessful, then repeat the login procedure, making 
sure that you type your username and password exactly as provided. These fields are case sensitive. If 
you still can’t gain access to the system, contact your system administrator. To change your password 
go to the Utilities menu off the Launchpad and click on Change Password.

Once you gain access to the system, you’ll be presented two applications, Launchpad and Message 
Handler. The number of applications you can invoke at one time is limited only by your system’s 
memory.

The Launchpad 

The Launchpad is the umbrella application from which all other HOSC applications are invoked. 
Essentially, it is a main application window. Just like other windows, it can be iconified. The 
Launchpad, however, has nothing displayed in its work area. It is initiated at system startup and cannot 
be closed without exiting the HOSC application software. Included in the title bar of the Launchpad is 
the name of the platform you are using, the project you are supporting, the mission, and the operational 
mode. The suite of applications available from the Launchpad is organized by function under several 
menu bar items. The menu bar items and individual menu items (applications) available to you depend 
on the project you are supporting, the type of account you requested, and your user profile. This 
information is maintained in the Launchpad Configuration File. 

For the general user, the Launchpad will consist of nine menus: 

■ File
■ Generation
■ Operation
■ Database
■ PIMS

Enter Enter
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■ PPS
■ Management
■ Utilities
■ Help

Privileged users may have one additional menu:

■ SMAC

Message Handler

The Message Handler application provides you with the capability to view messages generated by 
applications currently running for a particular project and mission. The Message Handler application is 
started when you login and cannot be exited, although it can be resized and iconified. All messages have 
several components describing the message including the time, the user identification (ID), the message 
priority, the message type, and the source of the message. The Message Handler application reads 
application messages from a buffer, applies the message selection criteria, and displays or stores these 
messages so that you can selectively view them. 

The Message Handler main window allows you to view system and application messages generated by 
the various HOSC applications (see Figure 1-1, Message Handler main window) For the Exception 
Monitor application, exception advisory messages are displayed in the main window of the Message 
Handler application. Status or error messages pertaining to the Exception Monitor application are 
displayed in the main window of the Message Handler application and the message area of the 
Exception Monitor main window. Within the main window you can:

■ Manipulate message filters so you see only those messages of particular interest
■ Configure the display columns so that you only see those aspects of messages with which you 

are most concerned 
■ Pause or control the rate at which messages are displayed 
■ Clear the messages currently displayed
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Figure 1-1, Message Handler main window

Starting Exception Monitor

The Exception Monitor application is available from the Launchpad under the Operation menu (see 
Figure 1-2, Launchpad Operation menu).

Figure 1-2, Launchpad Operation menu
Module 1 1-4 Workbook 3
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Exception Advisory Messages

The Exception Monitor application formats an exception advisory message as follows:

[Exception Type] Sensing Exception Advisory for [MSID] during [Data 
Mode] / Status was [LES Status] for [Last Refresh Value] / [EM Error 
Description] / [User Advisory Message]

Some examples of an exception advisory message might be:

Limit Sensing Exception Advisory for L01FK0021 during Real-time/
Status was WARNING LOW for 7.15 VDC/Heater VDC Temperature Exceeded 
Nominal Limit During Phase 1/Start computation heater 1 to collect 
data.

Expected State Sensing Exception Advisory for L81DZ0858 during 
Dump/Status was OUT OF STATE for OFF/This MSID was out of limits 
based on value of MSID L81DR0264/Monitor display FURNACE for 
anomalies.

The definition and size formats of variable fields are defined in Table 1-1, Exception advisory 
message formats.

Table 1-1,  Exception advisory message formats.

Field Definition
Max 

Length

Exception Type Indicates Limit, Expected State or Delta Limit  14 char

MSID Name of MSID causing the Exception  20 char

Data Mode Current Data Mode for Monitoring Process  11 char

LES Status OK, CAUTION LOW, OUT OF STATE,...  14 char

Last Refresh Value Calibrated sample value and units  20 char

EM Error Description As defined in the Telemetry Database  60 char

User Advisory Message As defined by the user  60 char
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Exercises

Instructions The following “Try It” allows you to setup an EM message filter. Carefully 
read and complete each step.   

Scenario Exception advisory messages can be longer than the default display column 
for the Message Handler application. For this reason you would like to 
configure the Message Text column to be wider and also, you only want to 
see Exception Monitor messages displayed.

Try It... 1. To setup a filter so that only EM messages are displayed, from the 
Message Handler main window, select Setup Message Filter... from the 
Options menu. Within the Message Type frame, toggle off all messages 
other than EM and click . From the File menu, select 
Close.

2. On the Message Handler main window, widen the Message Text column 
by selecting the Message Text column header so it becomes highlighted. 
From the View menu, select the Set Column Width... menu item. In the 
Width (characters) input text field, highlight the text and change to 120. 
Click .

Apply

Set
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Review 
Questions

Instructions Indicate an answer for each question below. The correct answers are given 
immediately following the questions.

1. What is exception monitoring?

2. Define the three types of LES violations.

1)__________:

2)__________:

3)__________:

3. What are two ways in which the Exception Monitor application can be 
invoked?

1)__________

2)__________
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Review 
Answers

1. Exception monitoring is a process which checks MSID values from 
telemetered data for violations of previously set limits or states.  

2. Limit violation occurs when an MSID value exceeds a predefined limit.   

State violation occurs when an expected state exception has occurred 
(e.g., OFF instead of ON).  

Delta limit violation occurs when the value of consecutive samples 
checked exceeds a defined delta.

3. User EM - invoked on the workstation

Project EM - invoked on the server.  
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Module 2
Exception Monitor Configuration Files

An Exception Monitor (EM) configuration file contains attributes for Measurement/Stimulus Identifiers 
(MSIDs) that have been enabled for exception monitoring. Upon initiating Exception Monitor, you will 
receive an empty configuration file. The work area is blank and the name of the file is displayed as 
Untitled on the application title bar (see Figure 2-1, Empty configuration file main window).

Note: For Project Exception Monitor, the title bar will only reflect Project Exception Monitor since no 
configuration files are used. The telemetry database will indicate which MSIDs are being monitored.

Figure 2-1, Empty configuration file main window

Creating a New Configuration File

After initiating Exception Monitor, you must open a previously saved configuration file or choose 
Create... from the File menu to create a new configuration file against a specific database.

Selecting the Create... menu item will invoke a dialog box that allows you to create a new configuration 
file based on a Pre-Released, Baselined or Archived database. The databases are defined as:

Pre-Released - A project telemetry database (PTDB) that has been validated for operational testing. 
Although you can create, validate, and edit a configuration file based on this type of database, you cannot 
actually start exception monitoring based on a pre-released database. If you attempt to start monitoring 

Application Title Bar

Work
Area

Status
Bar

Control
Panel

Area
Message
Workbook 3 2-1 Module 2



using a pre-released database, an error will be generated.

Baselined - A PTDB that has passed Data Verification, Regression Testing, System Validation, and 
Operations Validation. This database is currently being used in the Huntsville Operations Support Center 
(HOSC) for a particular mission activity.

Archived - A PTDB currently loaded as an archive that no longer reflects the current PTDB information. 
Only one archive database is available online at a time.

After creating a new configuration file, the work area of the main window will contain a table listing 
MSIDs and their attributes from the database you selected. This table is comprised of ten columns, 
although you will not be able to view all of these columns at once. You can use the scroll bar at the 
bottom of the table to view the columns that are not currently displayed (see Figure 2-2, New 
configuration file main window).

Figure 2-2, New configuration file main window

The columns list the following information:

The Enabled column indicates whether an MSID has been enabled for exception monitoring. If the 
MSID is enabled, the column contains a Yes. Otherwise, the column is blank and the MSID will be 
disabled. When the configuration file is initially created, all MSIDs are disabled for monitoring.

The MSID column contains the mnemonic of the parameter.

The Owner ID is used to group MSIDs together logically and to implement authorization.

The Group ID indicates to which group(s) the MSID belongs. Group IDs are identifiers in the telemetry 
database used to uniquely identify a group of measurements to be activated for Limit/Expected State 
(LES) sensing.

 Scroll Bar
 to See
Other
 Columns
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The Active Group column indicates the MSID’s current active group ID. Because an MSID can be 
associated with multiple groups, this column indicates which groups are active. Groups are activated by:

■ The value of a control parameter with or without a delay time
■ A start time
■ Manually via the Local Table Operation (LTO) application

Tip: If an MSID is a member of multiple groups and multiple groups are active, the group that is defined 
in the Telemetry Database as having the highest precedence will be the one used.

The LES Status column contains information regarding the LES sensing for the MSID. Possible values 
are:

■ OK indicates that the latest sample is within limits or as expected
■ NO DATA indicates data has not been available for this MSID
■ WARNING HIGH indicates in red that a warning high limit exception has occurred
■ WARNING LOW indicates in red that a warning low limit exception has occurred
■ CAUTION HIGH indicates in yellow that a caution high limit exception has occurred
■ CAUTION LOW indicates in yellow that a caution low limit exception has occurred
■ OUT OF STATE indicates in red an expected state exception has occurred (e.g., OFF instead 

of ON)
■ DELTA EXCEEDED indicates in red that the change in consecutive samples exceeded a delta 

value

Note: In order for delta limit sensing to be performed on an MSID, you must select All samples on the 
MSID’s Edit EM Attributes dialog box. 

The Last Refresh Value is a calibrated sample value of the MSID enabled for exception monitoring. 
This field is initially blank and is filled in when you click .

The # Samples column indicates whether the first or all samples in a packet are to be monitored. This 
field will contain either One or All.

The Ack Message is a flag to indicate that you are required to acknowledge receipt of an Exception 
Advisory Message for the associated MSID. This column will contain Yes if an acknowledgment is 
required or No if acknowledgement is not required; however, the field will remain blank until one of 
these options are selected. If this flag is not set, the EM message is sent to the message area of the 
Message Handler application. If this flag is set, the message will be sent to an acknowledgment dialog 
box and to message handler. If the Acknowledge Message attribute has been set to Yes for an MSID, 
and an exception advisory message is issued, you will be required to acknowledge the receipt of the 
message. Figure 2-3, Acknowledge Message dialog box shows how a notification message is displayed 
when the Acknowledge Message attribute has been set for the MSID.

           Refresh
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Figure 2-3, Acknowledge Message dialog box

The User Advisory Message column displays a user-defined message that is delivered as part of the 
exception advisory message when an LES violation occurs. The message is displayed in the message 
area of the Message Handler application.

Customizing the Main Window View

Exception Monitor has several features that allow you to customize the main window view based on 
your personal needs. You can rearrange the order of columns in the work area, make the columns visible 
or hidden, change the width of columns, hide the control panel and status bar, and change the size of the 
message area (see Figure 2-1, Empty configuration file main window).

Note: These settings will not be saved with the EM configuration file, and the main window view will 
return to the default settings after exiting and restarting the Exception Monitor application.

You can rearrange the order of columns and configure columns to be visible or hidden using the 
Configure Columns dialog box. This dialog box is invoked by selecting the Configure Columns... 
menu item located under the View menu (see Figure 2-4, Configure Columns dialog box). 
Module 2 2-4 Workbook 3



Figure 2-4, Configure Columns dialog box

Some columns may not be wide enough to display all of the associated data within each cell. If you 
receive a  at the right-side of a column, it indicates that there is more data than will fit in the cells 
width. You can change the column width by inserting your cursor into the column heading you wish to 
resize and selecting the Set Column Width... menu item under the View menu.

Note: Each column has a maximum number of spaces defined within the application. You cannot exceed 
this maximum.

The menu items that allow you to hide and show the status bar and control panel are located under the 
View menu. Both menu items toggle depending on what is currently being displayed (e.g., if the control 
panel is showing, the menu item will display Hide Control Panel, if the status bar is hidden, the menu 
item will display Show Status Bar).

Selecting Setup Message Area... under the View menu will invoke a dialog box that allows you to 
change the number of lines displayed in the message area. The message area of the Exception Monitor 
main window displays status or error messages pertaining to the application. LES violations are 
displayed in the message area of the Message Handler application. You can also change the number of 
lines displayed in the Message Handler message area.

Working with Databases

Exception Monitor allows you to set the data mode and database version for your configuration file and 
validate it against a telemetry database. After creating an EM configuration file, you can store it to the 
UDE database.
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Selecting Set Data Mode and Database Version... under the Options menu invokes a dialog box which 
allows you to set the data mode and the database version (see Figure 2-5, Set Data Mode and Database 
Version dialog box.)

Figure 2-5, Set Data Mode and Database Version dialog box.

The Data Mode frame contains three radio buttons (Real-time, Dump, and Playback). You can select 
the data mode by clicking on the appropriate button. If you select Playback for the data mode, you will 
need to also specify the playback channel (1-11). If you select Dump for the data mode, you must choose 
between the three available dump data modes:

■ Dump Mode 1 - S-Band Zone of Exclusion (ZOE)
■ Dump Mode 2 - Ku-Band Communication Outage Recorder (COR)
■ Dump Mode 3 - Ku-Band ZOE

Note: You cannot have more than one instance of Exception Monitor running on your workstation in 
the same data mode. If you attempt to start exception monitoring in a data mode already configured for 
use by another Exception Monitor application, you will receive an error message.

The Database Version frame contains the Telemetry Database: selection list. You can select a 
database version from this selection list.

The database version selected here will be reflected on the validate dialog box. If the currently open 
configuration file has not been validated against the selected database on Set Data Mode and Database 
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Version dialog box, the Validate dialog box will be invoked giving you the option to validate the 
configuration file.

Note: The current data mode and database version are displayed on the status bar of the Exception 
Monitor main window.

Validation consists of verifying that the MSIDs in the configuration file are contained in the database 
and that you have access privileges to them. Selecting the Validate... menu item under the Validate 
menu invokes a dialog box that allows you to validate your configuration file against the database. This 
dialog box will also be invoked if you have set your database version to a version that the configuration 
file has not been validated against (see Figure 2-6, Validate dialog box.).

Figure 2-6, Validate dialog box.

When you create a new EM configuration file, it is created using the corresponding local table for a 
selected telemetry database version. Therefore by default, the configuration file is valid for that database 
version.

Configuration files can be valid for multiple versions of a telemetry database and attributes contained in 
the file will take precedence over the same information in the telemetry database.
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If invalid MSIDs are encountered when validating a file already open, invalid MSIDs will be reported 
to the user along with the validation status.

If invalid MSIDs are encountered during validation that is occurring during the Open process, the invalid 
MSIDs will be removed from the configuration file and it will become <Untitled> to signify that it has 
changed. You will then need to save this configuration file. 

When you save an EM configuration file, it is stored on your workstation. To ensure that it is available 
for future login sessions and that it is made available to other users, you must store the file to the UDE 
database. The Store UDE and Retrieve UDE applications under the File menu on the Launchpad are 
used to store and retrieve your EM configuration files to the UDE database.

Exercises

Instructions The following “Try It” allows you to create an EM configuration file. 
Carefully read and complete each step.   

Scenario You want to create a new EM configuration file based on a Baselined 
database. You need to configure the columns of the table so that the Ack 
Message column is second, and you would like to hide the control panel to 
make the window smaller. You want to set the data mode to Real-time and 
validate it against the current database.

Try It... 1. To initiate the application, click the Operation menu from the 
Launchpad and then select Exception Monitor.

2. From the File menu on the Exception Monitor main window, select the 
Create... menu item to create a new configuration file. In the Create 
dialog box, select the Baselined telemetry database. Click . 
The main window will update to show the MSIDs defined in the 
telemetry database. By default, the MSIDs will be disabled for exception 
monitoring. 

3. To configure the columns so the Ack Message column will be displayed 
as the second column, click on the View menu and then select the 
Configure Columns... menu item. In the Configure Columns dialog 
box, scroll down on the Columns Visible: list until the Ack Message 
column is displayed. Select Ack Message and click on the Shuffle  
arrow up button until Ack Message appears second on the list. Select 

. The Ack Message column should now be the second column 
displayed in the work area of the Exception Monitor main window.

4. To hide the control panel, click on the View menu and select the Hide 
Control Panel menu item. 

Create

Configure
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5. To set the data mode, click on the Options menu and select the Set Data 
Mode and Database Version... menu item. On the Set Data Mode and 
Database Version dialog box, select the Real-time radio button within 
the Data Mode frame. Click . You will receive the Validate 
dialog box. Click . When the validation is complete, click  
to close the Validate dialog box and return to the main window.

6. To save your file, click on the File menu and select the Save menu item. 
In the Save: input text area on the Save As dialog box, enter your name 
and click . This saves the file locally to your workstation for a 
limited time period.

Set

Validate Close

Save
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Review 
Questions

Instructions Indicate an answer for each question below. The correct answers are given 
immediately following the questions.

1. What is an EM configuration file?

2. What will the application title bar display when using Project Exception 
Monitor? User Exception Monitor?

3. What will the work area of the main window contain after creating a new 
EM configuration file?

4. Where are LES violations displayed? Application status or error 
messages? Current data mode and database version?

5. What does validation consist of?

6. What will happen if invalid MSIDs are encountered when validating a 
file already open? During validation that is occurring during the Open 
process?

7. Where is a configuration file stored when you save it?

8. How can you make a configuration file available for future logon 
sessions?

9. How can you make a configuration file accessible to other users?
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Review 
Answers

1. Allows you to define the MSIDs that you want to exception monitor. Can 
be saved and used later.

2. It will have Project Exception Monitor on the title bar for Project EM. It 
will have just Exception Monitor on the title bar for user exception 
monitor.

3. It will contain every MSID defined in the database. All MSIDs will be 
disabled. 

4. LES violations - In the work area of the Exception Monitor application 
and in the work area of the message handler application

Application status or error messages - In the message handler area or the 
EM application

Current data mode and database version - In the status bar of the EM 
application.

5. Verifies that the MSIDs in the configuration file are contained in the 
database and that you have access privileges to them.

6. Validation occurring on file already open - The invalid MSIDs will be 
reported to the user along with the validation status.

Validation on file being opened - The invalid MSIDs will be removed 
from the configuration file and it will become <Untitled> to signify that 
it has changed. 

7.  The configuration file is stored locally on your workstation.

8.  It can be stored to the UDE database on the database server.

9. Mark it shareable using the UDE database application.
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Module 3
Exception Monitor Features

An Exception Monitor (EM) configuration file contains attributes for Measurement/Stimulus Identifiers 
(MSIDs) that have been enabled for exception monitoring or MSIDs that have a User Advisory Message 
defined. The attributes of these MSIDs include:

MSID - the mnemonic of the parameter.

Enabled - an indication of whether the MSID is enabled for exception monitoring.

# Samples - an indication of whether only the first or all samples of the MSID are to be monitored. 

Acknowledge Message - an indication of whether the user is required to acknowledge receipt of an 
exception advisory message for the MSID.

User Advisory Message - a user-defined advisory message that will be appended to the EM exception 
advisory message.

Editing EM Attributes for MSIDs

Selecting Edit EM Attributes... under the Options menu invokes a dialog box which allows you to edit 
the Exception Monitor attributes for a selected MSID (see Figure 3-1, Edit EM Attributes dialog box). 
This dialog box can also be invoked by selecting  on the control panel of the Exception 
Monitor main window. 

 Edit EM
Attributes...
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Figure 3-1, Edit EM Attributes dialog box

You can also invoke this dialog box by selecting Edit EM Attributes... from the Options menu.

You can enable and disable selected MSIDs for exception monitoring by selecting Enable or 

Disable under the Options menu or by selecting  or  on the control panel of the 

Exception Monitor main window. 

To select multiple MSIDs for enabling or disabling, hold down  and select individual MSIDs. 
To select a group of MSIDs, click on the first MSID you want in the group, hold down ,and 
then click on the last MSID. Click, drag, and release to select consecutive MSIDs on the list. To 
select/deselect all rows listed in the table, select Select All or Deselect All under the Edit menu.

Selecting Show Enabled Parameters under the View menu displays only those MSIDs which are 
currently enabled for exception monitoring. Selecting Show All under the View menu displays all 
MSIDs regardless of whether they are enabled or disabled for exception monitoring.

Enable Disable

Ctrl

Shift
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MSIDs/Groups

The radio buttons located directly below the status bar allow you to change what is shown in the 
main window work area. You can choose to view:

■ MSIDs
■ Groups

The MSIDs radio button is the default. When this radio button is selected, the work area displays 
all MSIDs that have EM attributes defined in a tabular format. Selecting the Groups radio button 
displays the groupings of MSIDs in which simultaneous activation or deactivation of Limit/
Expected State (LES) sensing can occur. Groups are MSIDs, defined in the database, which have 
been grouped together primarily for activation in LES sensing. This view allows you to see the 
active status of groups and whether they are enabled.

The Groups configuration (see Figure 3-2, Groups configuration) is comprised of four columns 
labeled as follows:

■ Enabled
■ Owner ID
■ Group ID
■ Active Status

Figure 3-2, Groups configuration

The Enabled column indicates whether a group is enabled for EM. If the group is enable, the 
column contains a YES, otherwise the column is blank.

The Owner ID is used to group MSIDs together logically and to implement authorization.
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The Group ID is the identifier used to uniquely identify the group of measurements that has been 
activated for LES sensing.

The Active Status column indicates whether the associated group is active. Groups are activated 
by:

■ The value of a control parameter with or without a delay time
■ A start time
■ Manually via the Local Table Operation (LTO) application

Note: If an MSID is a member of multiple groups and multiple groups are active, the group that is 
defined in the Telemetry Database as having the highest precedence will be the one used.

Filtering MSIDs

Filtering is performed on the work area tables to show which MSIDs are enabled or disabled for 
exception monitoring by a combination of MSID name, Group ID, and Owner ID. Selecting 
Filter... under the View menu invokes a dialog box which allows you to set filter criteria by which 
MSIDs/Groups are displayed in the main window (see Figure 3-3, Filter dialog box).

Figure 3-3, Filter dialog box

The filter is applied to what is currently displayed within the main window (i.e. if you apply a filter 
and then change the filter and apply the filter again, you are narrowing the list that is shown in the 
main window). After filtering the main window to display only certain MSIDs or groups, you can 
return to displaying all MSIDs or groups again by selecting Show All from the View menu.
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Note: The current filter status is displayed on the status bar of the Exception Monitor main 
window. If any MSID is being filtered, this field will display On; otherwise, this field will display 
Off (the default value).

Starting Exception Monitoring

To begin exception monitoring on enabled MSIDs, select Start EM under the Options menu or 
select  on the control panel of the Exception Monitor main window. A message will be 
sent to the Message Area of the main window notifying you that the process has started. After 
exception monitoring is started, you can disable/enable any MSID for monitoring.

To refresh the main window and get the latest information for enabled MSIDs, select Refresh 
under the Options menu or click  on the control panel of the Exception Monitor main 
window. The last refresh time is displayed on the status bar of the Exception Monitor main 
window. This field indicates the last time the work area was updated with new information. When 
an exception advisory message is issued for any MSID, the table will update with new information 
for all MSIDs within the table. This is the only time that the table automatically updates.

To stop exception monitoring on enabled MSIDs, select Stop EM under the Options menu or 
select  on the control panel of the Exception Monitor main window. A message will be 
sent to the Message Area of the main window notifying you that the process has stopped.

Printing

Selecting the Print Configuration File... menu item under the File menu invokes a dialog box 
which allows you to print MSIDs in the table that are currently enabled or have user advisory 
message definitions. The following is an example of a printed configuration file including a key 
that defines each line:

Line Description Example

version number 2.0

database revision number 0012

database revision Baselined

user id blanchmm

project SL

mission TST1

Start EM

Refresh

Stop EM
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Selecting the Print EM Report... menu item under the File menu invokes a dialog box which 
allows you to print either a User EM Report or Project EM Report. User EM Report prints a 
report of MSIDs enabled and being monitored on your workstation according to your 
configuration. Project EM Report prints a report of MSIDs enabled and being monitored by the 
project server.

The information in a User EM Report includes the following for each enabled MSID:

■ MSID name
■ Number of samples
■ Last refresh value
■ LES status
■ Active group ID
■ Acknowledge Message indication
■ User-specified advisory message

The Project Exception Monitor report provides the same information for all MSIDs being 
monitored by the project server. By requesting this report, you can ensure that you are not 
monitoring an MSID on your workstation that is already being monitored by the project server. 

Following is an example of a printed EM report:

Active   LES     Last #   Ack
MSID Group Status  Refresh Value Samples Message    User
==============================================================================
A07Q2005A   One
A07Q3002A         One
A66Q2001A   One     No      Open
A66W0003B   One

Tip: You can also view this information within the Telemetry Database and Local Table Operation 
applications. See Using the HOSC Telemetry Database and Local Table Operation Software 
(HOSC-EHS-1135). 

format: enabled?, MSID 
name, owner id, group id, ac-
tive group, LES status, Last 
Refresh Value, # samples, 
Ack message, user advisory

Yes,$E0TEST008,PSEUDO_OWNER_01, , , , ,One, ,
Yes,$E0TEST011,PSEUDO_OWNER_01, , , , ,One, ,
Yes,$E0TEST012,PSEUDO_OWNER_01, , , , ,One, ,
Yes,$E0TEST013,PSEUDO_OWNER_01, , , , ,One, ,
Yes,A71P2010A,USER-71,CR , , , ,One, ,
Yes,A71P2011A,USER-71,CR , , , ,One, ,
Yes,A71P2012A,USER-71, , , , ,One, ,

MSIDs with user advisory 
message defined are saved in 
addition to enabled MSIDs, 
even if they aren’t enabled.

,A71Q1001A,USER-71, , , , ,One,No,test2
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Exercises

Instructions The following “Try It” allows you to enable MSIDs for monitoring. 
Carefully read and complete each step.   

Scenario You want to enable several MSIDs for monitoring using the EM 
configuration file you created in Module 2. Before beginning exception 
monitoring, you also want to set an Acknowledge Message flag for two of 
the MSIDs and change the table view so that only enabled parameters are 
displayed.

Try It... 1. Use the scrollbar to search for the following MSIDs:
D71P2011A (Vax Floating Point with Limit Switching)
D71X4001E (Discrete Integer with Expected State Switching)
E71X2003E (Single Bit Discrete 0=off, 1=on)

2. Select them by clicking on each and holding down . Enable the 
selected MSIDs by clicking  on the control panel.

3. To configure an MSID listed in step one above for exception 
monitoring, select  on the control panel. On the Edit EM 
Attributes dialog box, select the Yes radio button in the Acknowledge 
Message frame. Enter the words “EM message 1” in the User 
Advisory Message input text field and click . Select another 
MSID and repeat the process. Enter the words “EM message 2” in the 
User Advisory Message input text field for this MSID. Use the scroll 
bar at the bottom of the work area to view the changes to the table.

4. To change the table view so that only enabled parameters are displayed, 
click Show Enabled Parameters from the View menu.

5. To begin exception monitoring, click  on the control panel. 
To update the information, click  on the control panel. 
Monitor the LES Status column for changes and acknowledge any 
advisory messages that are activated. Now, click . Exit the 
application by clicking on the File menu and selecting Exit....

Ctrl

Enable

Edit EM
Attributes...

OK

Start EM

Refresh

Stop EM
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Review 
Questions

Instructions Indicate an answer for each question below. The correct answers are given 
immediately following the questions.

1. What two ways can the Edit EM Attributes dialog box be invoked?

1)_________________________________________

2)_________________________________________

2. What three ways can you enable or disable an MSID for exception 
monitoring?

1)_________________________________________

2)_________________________________________

3)_________________________________________

3. How can you select multiple MSIDs for enabling or disabling?

4. What two different views can you choose in the main window work 
area?

1)_________________________________________

2)_________________________________________

5. What is filtering?

6. How can you tell if MSIDs have been filtered?

7. Can MSIDs be disabled/enabled after exception monitoring has begun?

8. What does the Refresh function do?

9. When is the table automatically updated?

10. How can you ensure that you are not monitoring an MSID on your 
workstation that is already being monitored by the project server?
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Review
Answers

1. By selecting the MSID and clicking Edit EM Attributes on the control 
panel or by selecting Edit EM Attributes from the Options menu.

2. Select the MSID and click Enable on the control panel, by selecting enable 
from the Options menu, or by invoking the Edit EM Attributes and 
enabling the MSID. 

3. To select multiple MSIDs for enabling or disabling, hold down  and 
select individual MSIDs. To select a group of MSIDs, hold down , click 
on the first MSID you want in the group and then click on the last MSID.

4. MSID or Group

5. Limits what is shown in the main window depending on the filter criteria that 
you set. Only those items that match your filter criteria are displayed in the 
main window.

6. Filter area of the status bar on the Exception Monitor main window.

7. Yes

8. Provides you with the latest information for the enabled MSIDs. The last 
refresh time is displayed on the status bar of the EM main window.

9. When new violations are received.

10. By printing a Project EM Report and comparing it to what you have enabled 
for user em.

Ctrl

Shift
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Course Summary

Exception Monitor (EM) is a process by which MSID values from telemetered data is checked for 
violations of previously set limits or states. For example, if the temperature of an on-board experiment 
is expected not to exceed 25 degrees Celsius, EM checks the MSID carrying the temperature of the 
experiment. If the value of the MSID exceeds the limit, the user is notified. This is known as a limit 
violation.

Another example might be an on-board heater that must be monitored to ensure whether it is on or off. 
If the heater is off (according to the MSID carrying this value) but it is expected to be on, the user is 
notified. This is known as a state violation.   

Another type of limit sensing is delta limit sensing. Delta limit sensing checks consecutive samples to 
see if the value has changed by a defined delta. If so, the user will be notified. 

In each of these cases, LES sensing is responsible for alerting the user that a violation has occurred. 
These messages will be displayed in the message area of the Message Handler application.

The current EM attributes for enabled MSIDs can be saved to an EM configuration file on your 
workstation for future EM sessions. Exception Monitor can be invoked on a workstation for local 
monitoring or on a project server for project-wide monitoring.

In this course, you learned how to build, edit and save an EM configuration file.  You also learned how 
to initiate the monitoring process. 
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Abbreviations and Acronym List
 A

a.k.a. also known as

A/G Air-to-Ground

A/M Automatic/Manual

ACBSP Assembly Contingency Baseband Signal Processor

ADQ Average Data Quality

ADR Achievable Data Rate

ADS Audio Distribution Subsystem

AIS Automated Information Security

AIT Analysis Integration Team

AM Amplitude Modulation

ANSI American National Standards Institute

AOS Acquisition of Signal

API Application Programming Interface

APID Application Process Identifier

Application Process Interface Definition

APM Attached Pressurized Module

APP Approved

APT Active Process Table

AR Action Request

ASCII American Standard Code for Information Interchange

ASCR Assured Safe Crew Return
Workbook 3 A-1 Acronyms



ASI Agencia Spatiale Italiano

AST Active Server Table

AT Address Translation

ATM Asynchronous Transfer Mode

ATT Attitude

B

B&D Boot & Diagnostics

BCD Binary Coded Decimal

BER Bit-Error Rate

BFS Backup Flight System

BG Bit-contiguous Group

BIA Bus Interface Adapter

BIT Built-in Test

BPDU Bitstream Protocol Data Unit

BPSK Binary Phase-Shift-Key

BRT BIT Response Table

BSP Baseband Signal Processor

BST BIT Summary Table

C

C&C Command and Control

C&DH Command and Data Handling

C&T Communications and Tracking
Acronyms A-2 Workbook 3



C&TS Communications and Tracking System

C&W Caution and Warning

C Counter-dependent

C C Programming Language

CADU Channel Access Data Unit

CAM Centrifuge Accomodations Module

CAP Command Acceptance Pattern

CAR Command Acceptance Response

CB Control Bus

CCA Canadian Space Agency

CCB Configuration Control Board

CCBD Configuration Control Board Directive

CCC Control Center Complex

CCIR International Radio Consultative Committee

CCP Central Command Processor

CCR Configuration Change Request

CCS Command and Control Software

CCSDS Consultative Committee for Space Data Systems

CD Compact Disk

CDB Command Database

CDD Command Data Definition

Context Dependent Decommutation

CDP Custom Data Packet

CDQ Current Data Quality
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CEU Control Electronics Unit

CG Comp Generation

CGM Computer Graphics Metafile

CHeCS Crew Health Care Systems

Chk Check

CI Configuration Item

CIC Crew-Interface Console

CLI Command Line Interface

CM Configuration Management

CMATS Configuration Management Asset Tracking System

CMD Command

CMIP Common Management Information Protocol

CMIS Common Management Information System

CNT Countdown Time

CO Comp Operation

COF Columbus Orbital Facility

COR Communications Outage Recorder

COTS Commercial-Off-The-Shelf

CPS Consolidated Planning System
Counts Per Second

CPU Central Processing Unit

CRC Circular Redundancy Check
Cyclic Redundancy Check

CRR Command Reaction Response

CS Communications System
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CSA Canadian Space Agency

CSC Computer Software Component

CSCI Computer Software Configuration Item

CSM Command System Management

CSMAC Communications Status Monitoring and Control

CSO Computer Security Official

CSOC Canadian Space Operations Center

CSS Central Systems Services

Command System Services

Coarse Sun Sensor

CSU Computer Software Unit

CUI Common User Interface

CVCDU Coded Virtual Channel Data Unit

CVT Common Value Table
Current Value Table

D

dB Decibels

dBW Decibels referenced to one Watt

DADS Data Acquisition and Distribution Services

DAE Data Acquisition and Extraction

DARL Database Access Routine Library

DB Database

DBA Database Administrator
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DBCG Database Coordination Group

DBCR Database Change Request

DBD Database Developer

DBMS Database Management System

DBS Database Services

DC Docking Compartment

DCM Document Configuration Management

DCN Document Change Notice

DCR Database Change Request

DCRG Distributed Control Room Graphics

DCS Digital Cross-connect Switch

DD AP Data Distribution Address Processor

DD NS Data Distribution Network Server

DDQ Data Data Quality

DDS Data Distribution System

DDT Display Data Table

DEMOS Distributed Earth Model Orbiter Simulation

DES Data Encryption Standard

DEV Development

DG Display Generation

DIST Distribution

DM Data Management

DMC Database Monitor and Control

Data Management Checklist
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DMP Dump

DoD Department of Defense

DO Display Operation

DOCR Datya Operations Control Room

DOSH Database Operational Support History

DP Distribute Packet

DPG Data Packet Generator

DPU Data Processing Unit

DQ Data Quality

DQM Data Quality Monitoring

DRAM Dynamic Random Access Memory

DRF Data Requirements Form

DS Digital Signal

DSM Docking & Stowage Module

DSID Data Stream Identifier

DSN Deep Space Network

DV Telemetry Display Verify

E

EC Experiment Computer

ECOMM Early Communications (S-band)

ECR Engineering Change Request

ECWA Emergency, Caution, Warning, and Advisory

EDDS Enhanced Data Distribution Switch
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EDS EMCS Data System

EEPROM ElectricallyErasableProgrammable Read Only Memory

EF External Facility

EGP Exterior Gateway Protocol

EGSE Experiment Ground Support Equipment

EHS Enhanced HOSC System

EIA Electronics Industries Association

ELF Extremely Low Frequency

ELM Experiment Logistics Module

E&M Electrical and Mechanical

EM Exception Monitor

EMCS Enhanced Mission Communications System

EML Extract MSID Library

EMU Extravehicular Mobility Unit

EPS Encapsulated Postscript

ERIS EHS Remote Interface Server

ES Expected State
Experiment Section

ESA/APM European Space Agency/Attached Pressurized Module

ESA/ATV European Space Agency/Automated Transfer Vehicle

ESA/ERA European Space Agency/European Robotic Arm

ESC Engineering Support Center

EVA Extravehicular Activity

EViDS Enhanced Video Distribution System
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EVoDS Enhanced Voice Distribution System

EXT FACIL External Facility

F

FCB Functional Cargo Block

FDD Flight Definition Data

FDDI Fiber Distributed Data Interface

FDF Flight Dynamics Facility

FEP Front-End Processor

FEPSC Front-End Processor Status and Control

FEW Front End Workstation

FIFO First-In-First-Out

FMT File and Memory Transfer

FOV Field-of-View

FPTNM Foot-Pounds to Newton-Meters

FSS Fine Sun Sensor

FSV Flight System Verifier

FTAM File Transfer Access and Management

FTP File Transfer Protocol

G

GB Gigabyte

GCID Ground Correlation Identification

GCMR Ground Control Message Request
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GG Ground to Ground

GHz Gigahertz

GKS Graphics Kerning Standard

GMT Greenwich Mean Time

GNC Guidance, Navigation, and Control

GOS-2 Grade of Service

GOSIP Government Open Systems Interconnection Profile

GP General Purpose

GPC General Purpose Computer

GPS Global Positioning System

GPU General Purpose Utilities CSCI

GR Ground Receipt

GRT Ground Receipt Time

GSE Ground Support Equipment

GSFC Goddard Space Flight Center

GTC Ground Testing and Checkout

GTR Ground Time Reference

GUI Graphical User Interface

GW Gateway CSCI

H

H/W Hardware

HAMASE HOSC Automated Model and Screen Editor

HAPS HOSC Advance Planning System
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HASA HOSC Administrative Software Account

HASS HOSC Activity Scheduling System

HCR HOSC Change Request

HDR P/L High Data Rate Payload

HLOG HOSC Automated Logging System

HMCG HOSC Management Coordination Group

HOSC Huntsville Operations Support Center

HPGL Hewlett Packard Graphics Language

HPR HOSC Problem Report

HRDL High Rate Data Link

HRDS High Rate Data System

HRF Human Research Facility

HSM High Speed Mux

HSMC Health Status Monitor and Configuration

HSR HOSC Support Request

HTT HOSC Training Team

HTTP Hypertext Transfer Protocol

HTV HOPE Transfer Vehicle

HUA HOSC User Assistance

HViDS HOSC Video Distribution System

HVoDS HOSC Voice Distribution System

Hz Hertz (formerly Cycles per Second)

I

Workbook 3 A-11 Acronyms



I/O Input/Output

IAN Institutional Area Network

ICD Interface Control Document

ICMP Internet Control Message Protocol

ICWG Interface Control Working Group

ID Identification

IDD Interface Description Document

IDQ Instantaneous Data Quality

IEEE Institute of Electrical and Electronics Engineers

I/F Interface

IGES Initial Graphics Exchange Standard

IGSS International Ground System Specification

IMPS Interim Mission Planning System

IP Internet Protocol

IRIG Interrange Instrumentation Group

IRIG-B Interrange Instrumentation Group, Standard B

ISCM Integrated Support Control and Monitoring

ISDN Integrated Services Digital Network

ISL Integrated Signal List

ISO International Organization for Standardization

ISPR International Standard Payload Rack

ISS International Space Station

ISSCB International Space Station Configuration Board

IST Integrated Support Team
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ITS Integrated Truss Segment

J

JCP JEM Control Processor

JDK Java Development Kit

JEM Japanese Experiment Module

JSC Johnson Space Center

K

kbps kilobits per second

kHz kilohertz

KERMIT The name of a file transfer protocol

KMTS-A Kennedy/Marshall Transmission System side A

KMTS-B Kennedy/Marshall Transmission System side B

KSAF Ku-band Single Access Forward

KSAR Ku-band Single Access Return

KSC Kennedy Space Center

L

LAN Local Area Network

LDP Logical Data Path
Logical Destination Processor

LDP_ID Logical Data Path Identifier

LHC Local Holding Clock
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LES Limit/Expected State Sensing

LOR Line Outage Recorder

LORSP Line Outage Recording, Storage, Playback Service

LOS Loss of Signal

LOV List of Values

LPS Launch Processing System

LSB Least Significant Bit

LSM Legal Station Mode, Life Support Module
Low Speed Mux

LSW Least Significant Word

LTE Local Table Edit

LTG Local Table Generation

LTO Local Table Operation

M

M Multi-syllable

Mbps Megabits per second

Mmax Maximum Allowable Downtime

MAS Media Archive System

MB Megabyte

MBF Mission Build Facility

MCC Mission Control Center

MCC-H Mission Control Center - Houston

MCC-M Mission Control Center - Moscow
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MCCU Mission Control Center Upgrade

MDB Mission Database

MDM Multiplexer/Demultiplexer

MEC Medical Equipment Computer

MET Mission Elapsed Time

MF Maintenance Fixtures

MH Message Handler

MHz Megahertz

MIB Management Information Base

MIC Media Interface Connector

MIL-STD Military-Standard

MIPS Mission Integrated Planning/Replanning System

MLP Multi-Line Phone

MMC (APM) Mission Management Computer

MOC Mission Operations Computer

MOL Mission Operations Laboratory

MOP Mission, Operational Support Mode, and Project

MPLM Mini Pressurized Logistics Module

MPDU Multiplexed Protocol Data Unit

MPS Mission Planning System

ms Milliseconds

MS Matrix Switch

MSB Most Significant Bit

MSFC Marshall Space Flight Center
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MSID Measurement/Stimulus Identifier

MSL Microgravity Science Laboratory

MSN Mission Systems

MSO Marshall Scheduling Office

MSS Mission Support Services
Mobile Servicing System

MSW Most Significant Word

MTBF Mean Time Between Failure

MTTR Mean Time To Restore

MUPS Momentum Unloading Propulsion System

N

NI-DDS NASA Communications System I Data Distribution System

NII-DDS NASA Communications System II Data Distribution System

N Normal

NASA National Aeronautics and Space Administration

NASCOM NASA Communications

NASDA National Space Development Agency of Japan

NCC Network Control Center

NCS Node 1 Control Software

NDE Non-operational Development Environment

NDL NRT Data Log

NDL Near Real-Time Data Logger

NEMS NASA Equipment Management System
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NG Bit Non-contiguous Group

NGT NASA Ground Terminal

NI NASCOM I

NISN NASA Integrated Services Network

NIST National Institute of Standards and Technology

NM Network Management

NMCC Network Management Control Center

NMS Network Management System

NPM Network Performance Monitoring

NPSS NASA Packet Switching System

NRT Near Real-Time

NRZ-L Non-Return to Zero Level

NRZ-M Non-Return to Zero Mark

NSOC NASDA Space Operations Center

NSS Network System Services

NSTS National Space Transportation System

NTM Net to Media

NTP Network Time Protocol

NTSC National Television Standards Committee

N/W Network

O

OBT Onboard Time

OC Operations Control
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OCC Operations Control Center

OCDB Operational Command Database

OCR Operations Change Request

OD Operational Downlink

ODA Office Document Architecture

ODF Operations Data File

OI Operational Instrumentation

OIU Orbiter Interface Unit

OOS Onboard Operating Summary

Ops Operations

ORU Orbital Replacement Unit

OS Operating System

OSF Open Software Foundation

OSI Open System Interconnection

OSTP Onboard Short Term Plan

OTE Operational Test Equipment

OTR Onboard Time Reference

P

PAP Payload Activity Plan

PB Playback

PC Polynomial Coefficient

PC Personal Computer

PCAD Pointing Control and Aspect Determination
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PCAP Payload Crew Activity Plan

PCDB Project Command Database

PCM PIMS Configuration Management
Pulse Code Modulation

PCTC/UDC Payload Crew Training Complex/Utilization Development
Capability

PDAC Procedures Development and Control

PDF Portable Document File

PDI Payload Data Interleaver

PDL Payload Data Library

PDRF Playback Data Request Form

PDSS Payload Data System Services

PFS Primary Flight System

PI Prime Item
Principal Investigator

PID Process Identifier                                                                                                                                                                  

PIMS Payload Information Management System

P/L Payload

PM Pressurized Module

PMA Pressurized Mating Adapter

PMCA Power Management and Control Application

PN Pseudorandom Noise

POCC Payload Operations Control Center

POD Payload Operations Director

POIC Payload Operations Integration Center
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PP Point Pair

PPS Payload Planning System

PRT Packet Routing Table

PS Parameter Select
Pressurized Section

PSCN Program Support Communications Network

psi pounds per square inch

PSP Payload Signal Process

P/SS PDSS System Support

PSS Project System Services

PTC Payload Training Complex

PTDB Project Telemetry Database

PUB Publication

PUI Program Unique Identifier

Q

QPSK Quadrature Phase-Shift-Key

R

R Range-dependent

RAM Random Access Memory

RCS Reaction Control System

RCU Remote Commanding Unit

RDBMS Relational Database Management System
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RDRP Raw Data Record Playback

ReGIS Remote Graphics Instruction Set

REL Released

RFI Radio Frequency Interference

RGB Red, Green, and Blue

RID Review Item Discrepancy

RP Retrieval Processor

RPM Rounds per Minute

RPSM Retrieval Processing Summary Message

RR Replanning Request

R-S Reed-Solomon

RS Recommended Standard

RSA Russian Space Agency

RSS Resident Size

RT Real-time

RTmax Maximum Repair Time

RTAS Radians to Arcsecs

RTC RealTime Command

RTD Radians to Degrees

RTDS Real-time Data System

RTI Remote Telephone Interface

RTN Return to Normal

RTS Requirements Tracking System
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Remote Tracking Station

RUM Remote User Machine

RW Reaction Wheel

S

S Super

S/A Sub/Address

SA Sub Address
Single Access

S&E Science and Engineering

SC State Code
Station Crew
Subsystem Computer

SCG Special Computation Generation

SCM Status and Configuration Manager

SCR Strip Chart Recorder

SDS Scripts Database Subsystem

SDT Shuttle Data Tape

SDV Systems Development and Verification

SEND KERMIT directive

SER Scientific, Engineering, and Research Systems

SGI Silicon Graphics Indy

Silicon Graphics Incorporated

SGML Standard Generalized Markup Language

SL Spacelab
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SM Service Module
System Monitor
Store Manager

SMAC System Monitor and Control

SMCM System Monitor and Control Configuration Manager

SMTP Simple Mail Transfer Protocol

SN Space Network

SNMP Simple Network Management Protocol

SOA Science Operations Area

SOD Shuttle Operational Downlink

SONET Synchronous Optical Network

SOPG Science Operation Planning Group

SPL Scratchpad Line

SQL Structured Query Language

SRD Serial Receive Device

SRS Software Requirements Specification

SS System Services

SSA S-band Single Access

SSAF S-band Single Access Forward

SSAR S-band Single Access Return

SSCC Space Station Control Center

SSCS Space to Space Communications System

SSCT Send Serial Clock Timing

SSH Secure Shell

SSGUI Scripting Services Graphical User Interface
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SSL Secure Socket Layer

SSL3 Secure Socket Layer 3

SSME Space Shuttle Main Engine

SSOR Space to Space Orbiter Radio

SSS Shared System Services

SSSR Space to Space Station Radio

SSUP System Services User Profile

STDN Spaceflight Tracking and Data Network

STS Space Transportation System

SUB Submitted

SUT SMAC User Team

SVF Software Verification Facility

T

T Typical

TAS Test and Simulation

TBA To Be Added

TBC To Be Confirmed

TBD To Be Determined

TBR To Be Resolved

TBS To Be Supplied

TCP/IP Transmission Control Protocol/Internet Protocol

TDB Telemetry Database

TDM Time Division Multiplexer
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TDRS Tracking and Data Relay Satellite

TDRSS Tracking and Data Relay Satellite System

TDS Telemetry Database Subsystem

Time Distribution System

TIFF Tagged Image Formatted File

TLM Telemetry

TMS Transport Management System

TNS Telemetry and Network Services

TNSDP Telemetry and Network Services Distribute Packet

TPS Telemetry Processing Services

TRW TRW Space Park

TTL Time To Live

TTY Teletype

U

UAS User Application Software

UDE User-generated Data Element

UDLT Universal Data Loop Transceiver

UDN User Defined Name

UDP User Diagram Protocol

UDSM User Data Summary Message

UFT Unrestricted File Transfer

UGSE User Ground Support Equipment

UHF Ultra High Frequency
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UI User Interface

ULC Unpressurized Logistics Carrier

UOA User Operations Area

UPAR User Profile Access Routine

UPD User Performance Data

URL Universal Resource Locator

USGS United States Ground Segments

USOS United States On-Orbit Segment

UTA User Telemetry Applications CSCI

V

VAX Virtual Address Extension

VC Virtual Channel

VCDU Virtual Channel Data Unit

VCID Virtual Channel Identifier

VMS Virtual Memory System

VT Video Terminal

VV Verification and Validation

W

WCP Workstation Command Processor

WEX Workstation Executive

WPL Word Processing Language

WPSPLUS Word Processing System PLUS
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WSGT White Sands Ground Terminal

WSC White Sands Complex

X

X Window X Window System

XMODEM The name of a file transfer protocol

XPDR Transponder

Z

ZOE Zone of Exclusion
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Glossary

Accelerator A sequence of keys that provides immediate access to applica-
tion functions. For example,  +  to invoke the New 
menu item.

Activation Type Method used within local table application to activate a group.  
The defined methods are Time and Control.

Active Window The workstation window that has input focus and in which 
keyboard entries impact and may appear.  See “Input Focus.”

Analog A mechanism in which data is represented by continuously 
variable physical quantities.

Application Main Window The primary window of a software application.

Application Process Identifier 
(APID) 

The APID is an 11-bit field that is included in Consultative 
Committee for Space Data Systems (CCSDS) headers.  It 
uniquely identifies the vehicle that created the source packet.

Application Title Bar The bar at the top of a main window that consists of the win-
dow menu button, the title area, and the minimize and maxi-
mize buttons.

Apply Pushbutton A pushbutton that implements any changes made within its 
dialog box, but leaves the dialog box on the screen so that 
additional changes can be made. See “OK Pushbutton.”

Approve In PIMS, this action is taken by a reviewer to signify his/her 
approval that a document, change request, or data request be 
placed in the baselined state.

Archived Database A telemetry database that no longer reflects the current real-
time telemetry characteristic information. Only one archive 
database is available online at a time.

Attributes Defaults Bar The area below the menu bar on the main window where 
application Text:, Line:, and Fill: default attributes are set.

Avtec A manufacturer of telemetry transmit and receive devices used 
in the Huntsville Operations Support Center (HOSC) 
Enhanced HOSC System (EHS) as the primary telemetry pro-
cessing hardware devices.

Baselined In PIMS, the final state of the review cycle. When a document, 
change request, or data request has been approved by all 
reviewers, the approver may place it in the baselined state.

Ctrl N
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Baselined Database Database that reflects the current real-time telemetry or com-
mand characteristic information for a particular mission activ-
ity. Baselined databases have completed validation.

Bitstream Protocol Data Unit 
(BPDU)

A protocol data unit of the bitstream function having a format 
of a header followed by a fixed length block of contiguous bit-
stream data.

Block NASA Communications (NASCOM) 4800-bit block format 
utilized for the transfer of data via the GSFC/MSFC Multi-
plexer/Demultiplexer (MDM) system.

Calibrated Three types of calibration exist for telemetry samples: polyno-
mial, point pair interpolation, and state code conversion. If 
calibration is requested, Telemetry and Network Services 
(TNS) automatically converts the unprocessed sample and 
then performs calibration on the sample for that Measurement/
Stimulus Identifier (MSID) as defined in the local table.

Cancel Pushbutton A pushbutton that allows a user to exit a dialog box without 
implementing any changes.

Cascade Menu A sub-menu or menu-within-a-menu that appears when you 
highlight a menu function that has an arrow to the right of its 
name. Cascade menus are used to group similar functions 
together beneath the pulldown menu.

Caution A standard icon used throughout the user guide set to repre-
sent destructive actions which could result in loss of data.

Caution Limits A range defined by a high and low value for an analog MSID 
in the Telemetry Database (TDB) and Local Table. A color 
code (yellow) represents values within those ranges in the 
application.

CCSDS Packet A source packet comprised of a 6-octet, CCSDS defined pri-
mary header followed by an optional secondary header and 
source data which together may not exceed 65535 octets.

Channel Access Data Unit 
(CADU)

Protocol data unit used for transmission from the ISS to the 
PDSS. A CADU  consists of a CVCDU that has been prefixed 
and delimited by a synchronization marker.

Click The action of pressing and releasing a mouse button. Typi-
cally, this is a left mouse button action.

Coded Virtual Channel Data 
Unit (CVCDU)

A VCDU to which a block of error-correcting Reed Solomon 
(RS) check symbols has been attached.

Command System Manager The position in charge of controlling the commanding system 
utilizing the Command System Managment software.  For 
AXAF projects, this is known as the PAYCOM position.
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Commercial-Off-The-Shelf 
(COTS) Software

Software applications that have been purchased from a com-
mercial software vendor as opposed to those that were devel-
oped internally.

Computation A FORTRAN or C program used to manipulate telemetry 
parameters. These programs are created by the Computation 
Generation application and are executed in Computation 
Operation.

Configuration Management 
(CM) Tools

Institutional applications that allow users to access and per-
form tasks, such as tracking requirements and equipment, 
scheduling resources, and logging into automated problem 
report systems.

Control Indicator Used to indicate that the group will be activated for limit/
expected state (LES) sensing with either the control MSID or 
a control MSID plus delay time.

Control Panel The area of a window where application pushbuttons and 
other graphical components are located.

Converted The process of translating raw telemetry data into an Ameri-
can National Standards Institute (ANSI) standard data repre-
sentation so that the sample can be properly interpreted by the 
machine which processes the data.

Counter-dependent A parameter whose occurrence in telemetry is dependent on 
an incrementing or decrementing counter in the data.

Critical Command A command whose initiation and execution could possibly 
cause damage to a payload or spacecraft and impair the mis-
sion.

Database Administrator An individual who is primarily responsible for managing the 
RDBMS engine and administering database accounts.  He/she 
also has the privilege to edit restricted database fields in any 
database, but is normally not recommended to edit data values 
that drive the telemetry and command processing for the EHS 
system.

Database Coordination Group A working group which includes representatives from the 
appropriate project operations personnel, project source DB 
developers, MOL DB developers and the HOSC validation 
team. Review and approve/dissaprove DBCRs, resolve con-
flicts and evaluate any DB related issues.

Database Developer An individual that has the privilege to edit restricted fields 
(e.g., decom, etc.) for both operational and non-operational 
databases that drive telemetry and command processing for 
the EHS system. 

Dataset A saved set of a command’s modifiable fields used to update a 
command prior to being transmitted.
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Data Stream Identifier (DSID) A field within a Secondary EHS Protocol Header for PDSS 
Payload Data used as a unique identifier for the data stream. 
This bit denotes if the type of data contained therein is 
CCSDS packet data (0) or BPDU (1).

Delivered Database A database must be delivered before it can become pre-
released.  A delivered database has not been validated for 
operational testing.

Delta Limit Maximum acceptable difference between consecutive samples 
of a parameter.

Desktop The computer monitor backdrop area on which all windows 
are opened. May also be referred to as workspace.

Development In PIMS, the first state of the review cycle in which a docu-
ment, change request or data request is still being written or is 
being updated.

Direction Keys A group of computer keyboard arrow keys which allow users 
to move up, down, left, and right within an application or 
menus.

Disapprove In PIMS, the action taken by a reviewer to signify disapproval 
and recommendation against moving a document, change 
request or data request into the baselined state.

Discrete Values Telemetry values that have states (e.g., on or off).

Double-click The action of pressing and releasing a mouse button twice in 
rapid succession.

Drag To press and hold down a mouse button while moving the 
mouse on the desktop (and the pointer on the screen). Typi-
cally, dragging is used while moving and resizing windows.

Drawing Tools Palette A group of tool buttons that is used to create graphic objects in 
order to display telemetry data, initiate commands, and start 
scripts and computations. The palette is located on its own 
floating dialog box or the application window.

Dump During periods when communications with the spacecraft are 
unavailable, data is recorded onboard and played back during 
the next period when communications resume. This data, as it 
is being recorded onboard, is encoded with an onboard 
embedded time and is referred to as dump data. When a near 
real-time (NRT) request is written specifying that dump data 
is desired, the onboard embedded time is used to fulfill the 
request.

Dynamic Objects Graphical objects that represent updating telemetry data.

Ellipse A geometric shape which can be created on a display (i.e., a 
plane of a cone, an oval shape, etc.).
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Expected State Text state code which indicates the nominal value of a param-
eter.

Expert Mouse Actions Clicks or double-clicks of mouse buttons which are non-stan-
dard and which activate special functions.

Filter The filter function is used within a dialog box to refine and 
define subsets of files you want to work with using a string 
search and wildcard. Characters can be used to implement the 
filter function.

Fonts A style of printed text characters.

Graphical User Interface (GUI) A way of interacting with computers using graphics-oriented 
software and hardware.

Grayed out A menu selection item that has been made insensitive, which 
is visually shown by making the menu text gray rather than 
black. Items that are grayed out are not currently available.

Greenwich Mean Time (GMT) The solar time for the meridian passing through Greenwich, 
England. It is used as a basis for calculating time throughout 
most of the world.  Displayed within the HOSC, it follows the 
format ddd:hh:mm:ss.

Grid A pattern of horizontal and vertical lines forming squares of 
uniform size on a display, used as a reference for locating 
points.

Group Parameter Composition Parameter composition where the bits of a parameter are con-
tiguous and a multiple occurrence of that parameter exists as a 
group of samples.

Groups MSIDs which have been grouped together, primarily for use 
with the Exception Monitor (EM) application.

Hazardous Command A command whose initiation and execution could pose a 
threat to human life or the entire mission.

Help A standard icon used throughout the user guide set to indicate 
that a cross-reference is provided to assist in solving problems 
or to answer questions.

Huntsville Operations Support 
Center (HOSC) 

A facility located at the Marshall Space Flight Center (MSFC) 
that provides scientists and engineers the tools necessary for 
monitoring, commanding, and controlling various elements of 
space vehicle, payload, and science experiments. Support con-
sists of real-time operations planning and analysis, inter- and 
intra-center ground operations coordination, facility and data 
system resource planning and scheduling, data systems moni-
tor and control operations, and data flow coordination.

I-beam Insertion Bar A graphical image used to represent the insertion point of text 
in a text entry area which provides a visual cue that text entry 
is anticipated by the system.
Workbook 3 B-5 Glossary



Icon A graphical representation of an object on the desktop. 
Objects can be minimized (iconified) to clear a cluttered 
workspace, and restored (opened), as needed.

Input Focus A window or window element that is activated and available 
for subsequent actions. Input focus is usually indicated by 
highlighting or changing the color of the activated element.

Input Slider An input object that allows users to change values of pseudo 
parameters and computational constants assigned to objects. 
Pseudos can be used in other applications (i.e., scripts, compu-
tations, etc.).

Insensitive An object or area of an application window that does not have 
input focus.

Integrated Support Team (IST) Institutional groups at the HOSC responsible for configuring, 
monitoring, and resolving problems with computer systems 
and application software.

Launchpad A floating menu bar that is used to initiate all HOSC software 
applications.

Legend A table that labels parameters plotted on a chart or grid.

Limit Delta Maximum acceptable difference between consecutive samples 
of a parameter.

Limit/Expected State Sensing 
(LES) 

A configurable option in Display Operation that allows the 
user to select whether he wants to see limit violation status or 
not. The incoming data is compared against the Local Table 
limits.

Limits Defined ranges for a measurement which are used to indicate 
off-nominal conditions: Caution High, Caution Low, Warning 
High, and Warning Low.

Line Plot A plot that uses lines to represent the relationships among 
telemetry values.

Local Table A subset of the TDB stored on a workstation or server used for 
telemetry processing.

Maximize Button A control button that is located to the right of the application 
title bar. When pressed, this button enlarges the application 
window to its largest state.

Menu Bar The area at the top of a window that contains the titles of pull-
down menus.

Merge The combining of data from different sources for a specific 
time slice.  During merge, the best (cleanest) data from each 
source will be used to create a contiguous segment of data for 
the specified time slice.

Message Area The part of the application window where system messages/
responses are shown.
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Message Dialog Box An area that provides information, gives the current status of 
data, asks questions, issues warnings, or draws attention to 
errors.

Mini-Application A secondary main window activated from within a main win-
dow application.

Minimize button A control button located to the right of the application title 
bar. When pressed, it iconifies the window.

Mission, Operational Support 
Mode, and Project (MOP)

A MOP is what delineates one EHS activity from another. 
MOP information is available in the common configuration 
file on every node.

Mnemonic An underlined character on a menu item, that allows users to 
initiate the item by typing letters on a keyboard.  A user-
friendly name used to reference a command residing in the 
command database.

Mode Independent Mode Independent is used to describe any process that is not 
dependent on a data mode.

Modifiable Commands Commands containing at least one data field which can be 
updated during operational activities prior to their uplink 
transmission.

Mouse A pointing device that is used along with a keyboard in point-
and-click user interfaces. The mouse used with HOSC work-
stations contains three mouse buttons. The left mouse button 
is used to activate and select items on windows. The middle 
mouse button is used for move functions. The right mouse 
button is used to access popup menus.

MSID Text Field An output object for viewing telemetry containing a label for 
the telemetry parameter, as well as the current value of the 
parameter displayed in a specified format (i.e., decimal, hex, 
octal, binary, American Standard Code for Information Inter-
change (ASCII), etc.).

Multiple Drawing Mode A mode that allows users to draw multiple objects of the same 
type.

Native Data Type Defined in the database and indicates how the MSID data will 
be interpreted in the HOSC.

Nominal A color code indicating expected conditions within defined 
limits of parameters.

Non-Shareable A flag has been set to prevent other users from retrieving your 
User-generated Data Element (UDE) from the UDE Database 
and using it on their local workstations.

Normal A telemetered parameter that occurs once per packet.

Note A standard icon used throughout the user guide set to direct 
your attention to specific items of concern.
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OK Pushbutton A pushbutton that implements any changes specified within a 
dialog box. The dialog box is dismissed after this pushbutton 
has been selected.

Option Menu Button A pushbutton which, when clicked, displays a menu of related 
options. The selected option is shown as the pushbutton label.

Output Slider An object that displays telemetry parameters. 

Packet A data unit comprised of octets that a source application gen-
erates.

Parameter Composition Describes how the bits of a parameter can be arranged in a 
packet for a sample(s) of that parameter.

Pixmap Object A picture that can be  drawn using the pixmap editor or 
scanned and assigned using the pixmap editor.

Playback Playback data can originate either internally or from some 
other facility. Project servers in the HOSC receive Playback 
telemetry streams from the HOSC Data Distribution System 
(DDS) and perform the same processing as would be per-
formed on real-time telemetry streams.

Pointer Sometimes called the mouse cursor, the pointer shows the 
location of the mouse on the desktop. The pointer’s shape 
depends on its mode. (e.g., on a window frame, the pointer is 
an arrowhead; while you are waiting for an action to com-
plete, the pointer becomes clock).

Point Pair Calibration A measurement which is calibrated using a series of linear 
segments. The linear segments are defined by a pair of points 
for each segment. Each point consists of a raw count value 
and a corresponding engineering unit value.

Pointer Shapes A graphical shape that a pointer assumes in the drawing mode 
(e.g., cross-hairs, I-beams, hour-glasses, etc.).

Polynomial Coefficient Calibra-
tion

A measurement is calibrated using the following polynomial 
calibration equation:
where:   eu - engineering units
cnts - counts
eu = COEF0 + (cnts1 x COEF1) + (cnts2 x COEF2) + (cnts3 x 
COEF3) + (cnts4 x COEF4) + (cnts5 x COEF5) + (cnts6 x 
COEF6) + (cnts7 x COEF7) + (cnts8 x COEF8) + (cnts9 x 
COEF9).

Popup Menu A menu that is invoked when the right mouse button is 
clicked. Functions available are the most common and vary 
from application to application.

Predefined Commands Commands completely defined prior to an operational activ-
ity.  Predefined commands contain no modifiable data fields.
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Pre-released Database A database that has been validated for operational testing.  It  
is used to validate UDEs (displays, comps, etc.) prior to the 
baseline release of the database.

Project Telemetry Database Contained within the Telemetry Database, includes the telem-
etry definitions needed to drive HOSC telemetry processing 
for a specific project/mission. The source of the real-time 
telemetry processing tables found in the Telemetry Local 
Table identified by a project/mission/revision prefix. Also 
included are tables to contain user copy data, an error log, and 
an Initial Load Table.

Protocol 1: Provides the formulas for passing messages, specifies the 
details of message formats, and describes how to handle error 
conditions. More importantly, it allows us to discuss commu-
nication standards independent of any particular vendor’s net-
work hardware. A communication protocol allows one to 
specify or understand data communication without depending 
on detailed knowledge of a particular vendor’s network hard-
ware. 2: A term referring to the type of source data used in the 
construction of an EHS packet. EHS Packet Protocols include: 
“C” - CCSDS packet, “P” - pseudotelemetry packet, “T” - 
encapsulated TDM packet, “B” - encapsulated block packet, 
and “D” - TDS packets.

Pseudo MSID/Parameter A parameter identification (ID) that has been assigned to con-
tain the output from a computation.

Pseudo Packet A telemetry packet consisting of external pseudo MSIDs. 
External pseudo MSIDs are generated (either by EHS compu-
tations or scripts), packetized and multicast on the project 
LAN.

Pulldown Menu A list or menu of possible options that is hidden under a gen-
eral phrase and invoked by clicking the left mouse button.

Pushbutton A control that causes an immediate action. To press a push-
button on the screen, point to it and click the left mouse but-
ton.

Radiobuttons A group of buttons that allows users to make only one selec-
tion at a time. Radiobuttons are small diamond-shaped but-
tons.

Range-dependent A parameter whose occurrence in telemetry is dependent on 
the value of a range parameter.

Real-time Data Real-time data is telemetered to the HOSC and distributed for 
immediate use. Real-time telemetry data, received into the 
HOSC system and written to the NRT log, is indexed by its 
time stamps and other identifying information. When an NRT 
request is submitted that covers a particular time slice, this 
indexing information is used to meet that request.
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Recall Text Area within an application that allows users to input up to 256 
characters.

Release In PIMS, an action taken by the manager of a document or 
request that releases it from the baselined state back into the 
development state for modifications.

Resize Borders The area that surrounds the framed area of an application, and 
is used to change the height or width of the window.

Resize Handles Up to eight handles surrounding an object that allows users to 
resize objects, displays, or windows.

Review In PIMS, the second state of the review cycle in which the 
document, change request or data request has been written and 
submitted for review and approval.

Sample Composition Describes how the samples of a parameter are arranged in a 
major frame.

Scatter Plot A plot that uses unconnected dots to represent the relation-
ships among telemetry values.

Scratchpad Line (SPL) Direc-
tives

Provides users with the capability to start and stop displays, 
computations, and scripts. A user may also uplink and modify 
commands and update pseudo MSIDs through the use of SPL 
directives.

Script A file containing a sequence of directives that can be invoked 
in a single step.

Scroll Bar A control that allows the contents of a window area to be dis-
played without resizing a window or list.

Select Button The mouse button used for most operations. By default the 
select button is the left mouse button.

Set Pushbutton A pushbutton that allows a user to implement changes based 
on selections made within a dialog box. Reacts like the OK 
pushbutton and closes the dialog box.

Setup Message Area The dialog box that allows users to change the number of lines 
displayed within the message area of the application main 
window.

Shareable A flag has been set to allow other users to retrieve your UDE 
from the UDE Database and use it on their local workstation.

Shotgun Parameter composition when the bits of a parameter are scat-
tered in multiple non-contiguous words of a major frame.

Slider Box A graphical component of the scroll bar, which is dragged to 
provide a different view of the same file, list, or text area.

State Code Calibration A measurement is converted to a text state code.

Static Object A graphical object that is not receiving telemetry data.
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Status Bar A feature that allows the viewing of application critical con-
figurations within the main window.

Submit In PIMS, an action taken by the manager of a document, 
change request, or data request in which the document or 
request is placed in a state of review and approval and released 
from development.

Subset A collection of measurements from the total measurement set 
that is bounded as an integer number of octets but does not 
constitute the packet itself. A mini-packet.

Super A parameter that occurs more that once per packet.

Superseded Database If a baselined database already exists for a  project and mis-
sion, before a new baselined database can be released, the cur-
rent baselined database is designated as superseded.

Switch MSID A parameter whose value determines which limit or calibra-
tion set will be used for the specified MSID.

TDM Time Division Multiplexed - a technique for transmitting mul-
tiple parameters within a single serial bit stream by interleav-
ing them, one after the other.

Time Indicator Indicates that a group will be activated based on a defined 
start time and deactivated based on a defined stop time.

Time Plot A plot against time containing up to four Y-Axis parameters.

Time Reference A time format that is represented in either GMT or Mission 
Elapsed Time (MET).

Time Tag A time reference marking an event. For example, a parameter 
goes out-of-limits at 230:16:00:00. The time tag for the out-
of-limit event is 230:16:00:00.

Tip A standard icon used within the HOSC user guide set to indi-
cate that suggestions or hints are provided.

Togglebuttons Small buttons that can be switched “on” or “off.” To switch a 
togglebutton, point to it and click the select button. Black indi-
cates that the desired attribute is in effect or “on.”

Tolerance Number of times the MSID exceeds the limit value before an 
EM warning message is issued.

Typical Parameter composition when the bits of a parameter are con-
tiguous.

Unprocessed Raw telemetry data.

User-generated Data Element 
(UDE)

A user-generated file. For example, a display, script, computa-
tion, pixmap, etc., is a UDE.
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User Data Summary Message 
(UDSM)

A PDSS Data Quality packet. Information contained in the 
packet includes: the start/stop time of the UDSM report 
period, the number of unplanned LOS occurrences, the num-
ber of BPDUs or packets per DSID received, the number of 
VCDU sequence counter errors, and the number of packet 
sequence counter errors per DSID.

Virtual Channel (VC) A CCSDS construct whereby a physical communications 
channel is shared among different users, each of whom uses 
part of the available bandwidth for a virtual channel of 
CCSDS CADUs incorporating predetermined CCSDS identi-
fiers for each user.

Virtual Channel Identifier 
(VCID)

A binary identifier located within the VCDU header, which 
when concatenated with the spacecraft identifier, uniquely 
identifies a particular spacecraft virtual channel.

Virtual Channel Data Unit 
(VCDU)

A CCSDS data set of specific structure and fixed length, 
which includes CCSDS specified headers and into which user 
data is packaged for transmission over the space-to-ground 
link.

Warning Limits A color code (red) representing limit violations of a parame-
ter.

Wildcard Placeholders for other characters in a string.  Three wildcards  
are permitted in most HOSC applications. The “*” represents 
any combination of characters and the “?” represents any sin-
gle character. A blank can be used to replace a single “*” to 
indicate “all”.  Database applications use Oracle as their basis; 
therefore, “%” is used like the “*” and an underscore charac-
ter “_” is used like the “?”.  Blank operates the same way in 
database applications as in other HOSC applications and rep-
resents “all.”

Window Menu The menu that appears when you press the window menu but-
ton, which is located to the left of the application title bar on a 
window frame. Every window has a system menu that enables 
you to control the position of the window.

Workspace The area on a terminal where the windows of a user’s environ-
ment appear. The workspace is sometimes referred to as a 
desktop or root window.

XY Plot A plot that contains one X-Axis and up to four Y- Axes 
parameters.
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